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PERFORMING CALCULATIONS WITH FORMULAS AND
FUNCTIONS
INTRODUCTION
Excel 2007 makes it easy to reference a number of cells at once, allowing you to
define your calculations quickly.
NAMING GROUPS OF DATA
When you are working with a large amount of data, it is often useful to identify
groups of cells that contain related data. Whenever you want to use the contents
of a range in a calculation, you can simply use the name of the range instead of
specifying each cell individually. If the cells you want to define as a named range
have a label you want to use as the range's name, you can display the Formulas
tab and in the Defined Names group, click Create from Selection to display the
Create Names from the Selection dialog.
When you click a named range, Excel displays the cells it encompasses in the
Refers to field.
To create named ranges to streamline reference groups of cells:
1.
Continuing from the previous exercise, launch Excel in your favorite manner.
2.
Open VehicleMiles from the student folder.
3.
Select cells C4:G4.
4.
In the Name box on the left of the formula bar, type V101LastWeek.
5.
Depress Enter.
6.
Select Formulas|Defined Names group|Name Manager.
7.
At the Name Manager dialog, at the Name… area, click the V101LastWeek name.
The cell range appears in the Refers to field.
8.
9.

Edit the cell range in the Refers to field to =MilesLastWeek!$C$4:$H$4.
Click the check buttons next to the Refers to field.
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The address has been modified in the Name Manager.
10.
11.
12.
13.

Click Close.
Select the range C5:H5.
Select Formulas|Defined Names group|Define Name drop-down|Define Name.
In the Name field, type V102LastWeek.

14.
15.
16.
17.
18.

Confirm the definition in the Refers to field is =MilesLastWeek!$C5:$H$5.
Click OK.
Save the current file as My VehicleMiles.
Click anywhere in the spreadsheet.
Click the drop-down in the Name Box and select V101LastWeek.
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The first range is selected.
19.

Click the drop-down in the Name Box and select V102LastWeek.

The second range is selected.
20.
21.
22.
23.
24.

Click on the Insert Worksheet button.
On the new worksheet, click the Name Box drop-down.
Select either entry and the selected range is displayed.
Close the current file, saving your changes.
Leave the application open for the next exercise.

CREATING FORMULAS
A formula is an expression that performs calculations on your data. Typing cell
references can be very tedious and typo-prone so Excel makes it easy to handle
complex calculations.
The following describes some of the most useful functions offered by the system:
Function

SUM()
AVERAGE()
COUNT()
MAX()
MIN()
NOW()
PMT()

Description

Finds the total of the numbers in the specified cells
Find the average of the numbers in the specified cells
Finds the number of entries in the specified cells
Finds the largest value in the specified cells
Finds the smallest value in the specified cells
Returns the time the workbook was last opened. This
value changes ever time the workbook is opened
Calculates payments due on a loan, assuming constant
interest rate and constant payments

The elements to be entered into the function are called arguments and must be
entered in a certain order. You can also use the names of any ranges you have
defined to supply values for a formula. If you want to include a series of
contiguous cells in a formula, but you have not defined the cells as a named range,
you can click the first cell in the range and drag to the last cell. In the event the
cells are not contiguous, depress the Ctrl key and click the cells to be included.
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After you have created a formula, you can copy and paste it to another cell with
the system changing the formula so it works in the new cells.
To create a formula manually, revise it to include additional cells, create a
formula that contains a table reference, create a formula with relative references
and change the formula so is contains absolute references:
1.
Continuing from the previous exercise, open ITExpenses from the student folder.
2.
Confirm the Summary worksheet is active.
3.
Click in F9, type, =C4 and depress Enter.
The value from C4 is copied into F9.
4.
5.

Select F9 again.
Replace the current value in the formula bar with =SU

Formula's AutoComplete displays a list of possible functions.
6.
7.

Double-click on SUM.
After the open parentheses select C3 and drag to C8.
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8.

Complete the function by typing the closing parentheses and depressing Enter.

9.

Click on F10, type =SU, repeating the above, complete the formula by selecting
C4:C5 and clicking the  symbol displayed in the formula bar.
Select F10, select the C4 in the formula bar and depress the Function4 key.

10.

The selection is modified to an absolute cell reference.
11.
12.
13.

Repeat the above, marking C5 as absolute.
Click the JuneLabor worksheet tab.
In cell F13, type =SUM(J

The name of the existing table is displayed.
14.
15.

Depress TAB to insert JuneSummary into the formula.
Type [ and click on Labor Expense followed by another Tab.

16.

Type the closing ]) to complete the formula and depress Enter.
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17.
18.
19.
20.
21.
22.

Save the current file as My ITExpenses.
Click any cell in the table.
Select Table Tools|Design|Tools group|Convert to range.
At the query, click Yes.
Close the current file.
Leave the application open for the next exercise.

SUMMARIZING DATA WITH SPECIFIC CONDITIONS
Another use for formulas is to display messages when certain conditions are met.
This kind of formula is called a conditional formula and uses the IF function.
When you work with an IF function, the Function Arguments dialog displays.
To create a conditional formula that displays a message if a condition is true,
find the average of worksheet values that meet one criterion and find the sum of
worksheet values that meet two criteria:
1.
Continuing from the previous exercise, open PackagingCosts from the student
folder.

2.
3.

In cell G3, type =IF(F3>=35000,"Request Discount","No Discount Available")
and depress Enter.
Click in G3 and drag the fill handle down to G14.
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The results of the copied formulas appear in the selected cells.

4.

Click I3 (eye3), type =AVERAGEIF(C3:C14,"=Box",F3:F14) and depress Enter.

The value$46,102.50 inserted in I3 represents the average cost per category of
boxes.

5.

In I6 (eye6), type =SUMIFS(F3:F14, C3:C14,"=Envelope",E3:E14,
"=International") and depress Enter.

The value $45,753.00 inserted in I6 represents the total cost of all envelopes used
for international shipments.
6.
7.
8.

Save the current file as My PackagingCosts.
Close the current file.
Leave the document open for the next exercise.

FINDING AND CORRECTING ERRORS
It is possible for errors to sneak into your formulas. The process of examining a
worksheet for errors in formulas is referred to as auditing.
The following lists the most common error codes and what they mean:
Error Code

#####
#VALUE!
#NAME?
#REF!
#DIV/0!

Description

The column is not wide enough to display the contents
The formula has the wrong type of argument
The formula contains text that Excel does not recognize
The formula refers to a cell that does not exist
The formula attempts to divide by zero
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To use the formula auditing capabilities in Excel to identify and correct errors in
a formula:
1.
Continuing from the previous exercise, open ConveyerBid from the student folder.
2.
Click in D20.

3.

Select Formulas|Formula Auditing group|Watch Window.

A Watch Window displays.
4.

Click the Add Watch button located at the top of the Watch Window.

5.

In the Add Watch dialog, click Add.

The information from D20 is added to the Watch Window.
6.
Click D8 to display the accompanying formula.
7.
Select Formulas|Formula Auditing group|Trace Precedents.

The arrow displays between D8 and the cell range of C3:C7, indicating the cells in
the range C3:C7 are precedents of the value in D8.
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8.
9.
10.

Select Formulas|Formula Auditing group|Remove Arrows.
Click A1.
Select Formulas|Formula Auditing group|Error Checking|Error Checking.

An error is detected in D21.
11.
12.
13.

Click Next.
No additional errors are detected so click OK.
Select Formulas|Formula Auditing group|Error Checking drop-down|Trace
Error.

The arrow points to D21 from C12 and D19. These arrows indicate using the
values or lack of values, in the indicated cells generated the error in D21.
14.
15.

Select Formulas|Formula Auditing group|Remove Arrows|Remove Arrows.
In the Formula bar, modify the formula to read =C12/D20 and depress Enter.
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The correct value now displays in D21.
16.
17.

Click in D21.
Select Formulas|Formula Auditing group|Evaluate Formula.

18.

At the Evaluate Formula dialog, click the Evaluate button three times to step thru
the formulas elements.
Click Close.
In the Watch Window, click the current watch in the list.
Click the Delete Watch button.
Select Formulas|Formula Auditing group|Watch Window.

19.
20.
21.
22.

The Watch Window closes.
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USING AUTOFILL
Autofill allows you to quickly fill data in a series, e.g. months, days of the week, or
a numeric series, into adjacent cells.
USING AUTOFILL WITH A TEXT SERIES
To use the Autofill function with text, type in the first word of the series, e.g.
January, rest your mouse on the bottom right corner of that cell, and you should
see the Autofill cross.
Click and drag the series down or across the appropriate number of cells.
Excel knows how to Autofill months (January or Jan) and days of the week
(Monday or Mon). You can teach Excel to Autofill other text series by going to
Office|Excel Options|Popular, and then clicking on Edit Custom Lists....
USING AUTOFILL WITH A NUMERIC SERIES
You can also use Autofill to quickly enter numeric patterns, e.g. 1 2 3 or 10 20 30,
into adjacent cells.
To use Autofill with numeric patterns, enter the first two values in the series, one
value in one cell and the next in the cell immediately below or to the right. Now
select (highlight) both cells, release your mouse button, then rest your cursor on
the bottom right corner of the selected area so you see the Autofill cross.
When you see the Autofill cross, click and drag down or across the cells you want
to fill, then release the mouse button. Double-clicking the Autofill cross will result
in an automatic filling of the cells below until it reaches a blank row.
Autofill becomes important again when constructing formulas.
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CONTROLLING YOUR VIEW OF THE DATA

Auto Size: You may have noticed that sometimes data extends beyond the
width of the column. In order to be able to see all of the data, you must
widen the column. To do this, go to the header row and place your mouse in
between the columns, e.g. on the line that separates the letters A and B. You
will notice that your mouse becomes a black double arrow. If you double
click on this arrow, the column will automatically size itself to fit the longest
string of data in a cell. However, this does not adjust automatically so you
may have to Auto Size again after adding more data.

Freeze Panes: Freeze Panes is a useful feature when you are working with a
large document that has many rows. By freezing a certain row, usually the
header, you make that row visible wherever you are in the document. For
example, if you have a document with 100 rows, you can't see the header
row when you're at cell A100. To solve that problem, click on the row below
the one that you would like to freeze. To freeze the header row, click on the
cell in the second row and first column. Then go to Freeze Panes under the
View tab.
It's important to note you can freeze columns as well as rows. If you just
click at an arbitrary point in the second row, not only will you freeze the top
row, you'll also freeze all columns to the left of the cell you've selected.

Reveal Formulas: If you want to see and/or print all of the formulas in a
spreadsheet, as opposed to the values, there is a really handy shortcut.
Simply depress Ctrl + ~. To return the view to displaying values, depress
Ctrl + ~ once again.
SORTING AND FILTERING DATA
You can order your data from the Sort window in ascending or descending order
as well as based on multiple header values.
Sorting data is simply a way of automatically re-ordering rows on a spreadsheet
to put them in a more useful order. For instance, you might sort an address book
alphabetically by last name, or a list of items you'd like to buy from most
expensive to least expensive.
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Start by selecting the data you want to sort. It's important to select all the columns
in the data, not just the column you want to sort by. For instance, if you have a list
of items in one column, with the prices in the next column, you would select both
columns before running the sort. If your sheet has a "header row" at the top with
labels for your columns, like "name," or "price", it's a good idea to include that row
in your selection as well, as you'll see in a moment.
Once you have your data selected, click on the Data tab and then click on Sort. If
your data has a header row, be sure the "My data has headers" bubble is filled in
at the top. Excel will then use your labels in the "Sort by" boxes instead of the
usual (unhelpful) "Column A," "Column B," etc.
Now you can use the "Sort by" box to select the column you'd like to sort the data
by. If that column contains text, it will sort alphabetically or if the data is numeric
it is sorted in number order. You can add levels in order to sort by more than one
field, by last name and then by first name, for example.
Another way to organize data is to filter it. A filter only displays data that meet a
certain criteria, such as all records for a certain day. To do this, go to the Data tab
and click on Filter. A dropdown arrow will appear in the header cell of each
column of your worksheet. Click on the arrow and select the criteria that you
would like to use as a filter, e.g. April 10th.
The worksheet will now display only the records from that day. You can also use
the Filter tool to display the top or bottom 10 numbers in a column, only records
with blank spaces in that particular column, records that have a value greater than
a certain number in the column that you are filtering, etc. These options are all
available under the dropdown arrow that you will see after going to the Data tab
and clicking on Filter.
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FORMULAS
Select the cell that the formula result is going to be displayed in. The formula can
be constructed in the formula bar. You will always need to put the = sign before a
formula. That is how Excel recognizes what you are entering as a formula.
Sign
*
*
/
(...)

Operation
Addition
Subtraction
Multiplication
Division
Combination

Example
=A1+B1+C1+D1
=A1-A2
=C4*C5
=C4/D4
=A1*(B1+C1)

Click on the checkmark to enter the formula, the x to cancel the formula.
AUTOFILL WITH FORMULAS
Autofill helps you fill in formulas quickly once you have constructed one in a cell.
In order to Autofill, select the cell with the formula. Place your cursor so the small
black cross appears in the lower right corner of the cell (+). Once that cursor is
visible, simply drag your formula down the column (or across the row as the case
may be). Autofill will change the cell references accordingly.
Note that cell references can also change automatically when you copy and paste a
formula using the clipboard, unless you use an absolute cell reference, e.g. if the
formula in A3 is =A1+A2, when you drag that formula over to B3 then the
formula becomes =B1+B2.
CELL REFERENCES

Relative Cell References: cell references that change when the formula is
autofilled into different cells, as in the example above.

Absolute Cell References: if you don't want a certain part of your cell
reference to change when you copy the formula to a new cell, you need to
put a $ in front of that part, e.g.: If the formula in A3 is =$A$1+A2, when
you drag that formula over to B3 the formula becomes =$A$1+B2.
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AUTOSUM
The AutoSum button on the Home tab allows you to quickly insert the SUM
function. Select the cell where you want to put the total and then click on the
AutoSum button ( ). Excel will insert the SUM function and take a guess as to
what cell range you'd like to sum. Check to make sure the cell range is correct,
then depress enter to accept the function.
FUNCTIONS
Excel has created hundreds of functions that prevent you from having to write out
complex or repetitive formulas yourself. The cells that you want to perform the
function on are either listed, separated by commas, or included in a range of
numbers, indicated by a colon in between the first number in the range and the
last number in the range.
Functions can be inserted by manually typing them in, by clicking on the Paste
Function button on the Ribbon, if you're copying one from somewhere else, or by
typing = in the formula bar and choosing the function from the drop down list on
the left.
Functions can also be 'nested'; that is, inserted into larger functions, by using the
appropriate amount of brackets such as =AVERAGE(SUM(B2:F2), SUM(B3:F3))
THE FUNCTION WIZARD
You can quickly generate valid functions using the function wizard. To open it,
click the function wizard button in the formula bar (looks like a "fx" symbol). It
provides a description of the function you select, a space for you to enter in the
range or numbers and previews the Formula Result.
You can select a range from your sheet rather than typing it in manually by
clicking on the little button with the red arrow to the right of the Value box.The
function wizard allows you to build custom functions to suit your specialized
needs. It also offers many built in functions which you can utilize.
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The Function Wizard is best used when you know Excel probably has a certain
functionality, but aren't sure what the function is called exactly or how to use it.
AUTOCALCULATE
Excel will automatically perform calculation on a set of cells that you select and
display the results on the status bar. The default calculation is the SUM function,
but you can change the calculation by right-clicking on the AutoCalculate result.
USING NATURAL LANGUAGE LABELS
Excel has a convenient labeling feature which allows you to name your cells,
columns and rows. You can then use your names to build formulas and functions
in place of the cell references. For example, you can label one cell "length" and
another cell "width," and then the formula =length*width would find the area of
whatever you're measuring.
You can also assign names to data ranges. For instance, you could select cells
A1:C14, then go up to the Formulas tab and click on Define Name, where you can
set a name for the range. You can then use that name in formulas and functions.
Just keep in mind that the names you define cannot have spaces, so use an
underscore if necessary.
All names are defined using Define Name. An alternate way is by selecting a
range of cells and then typing in a name in the dropdown box to the left of the
formula bar.
3-D REFERENCES
"3-D" references allow formulas on one worksheet to access data on another
worksheet. You can even link a formula to a cell in a completely different
workbook, although unless you're working on a very large project this generally
isn't worth the hassle.
Using your mouse, you can easily use data and formula results from other
worksheets in your formulas and functions. The fastest way to do this, when
composing a formula, is to move to the worksheet that has the information you
want to use, and then click on the cell.
Page 18
\\OFFICE-XP\XP_My Documents\1_Presentation Choices\Clients\Starlight Education\Web Site\Htdocs\files\Formulas Functions Excel 2007.doc
Last printed 7/24/2012

Excel 2007 – Formulas and Functions
STARLIGHT EDUCATION, INC.
Training Division
Special Edition

The result will look something like what's below. You can then add
operations/more data, or simply depress Enter. Excel will accept the data from
another sheet, no problem.
A cell reference within the current worksheet

B5
23.
24.
25.

A cell reference in the Budget worksheet

Budget!B5
Save the current file as My ConveyerBid.
Close the current file.
Close the application

CHANGING THE APPEARANCE OF DATA BASED ON VALUE
Another way you can make your data easier to interpret is to have the system
change the appearance of your data, based on its value. These formats are called
conditional formats because the data must meet certain conditions to have a
format applied to it.
In previous versions of Excel, you could have a maximum of three conditional
formats. There is no limit in this version, you may have an many conditional
formats as you need. The Conditional Formatting Rules Manager is new in Excel
2007 and allows you to control your conditional formats in several ways. After
you create a rule, you can change the format applied if the rule is true by clicking
the rule and then clicking the Edit Rule button.
Be sure to not include cells that contain summary formulas in your conditionally
formatted ranges. The values, which could be much higher or lower than your
regular cell data, could throw off your formatting comparisons.
To create a series of conditional formats to change the appearance of data in
worksheet cells displaying the package volume and delivery exceptions rates of a
regional distribution center:
1.
Continuing from the previous exercise, open Dashboard from the student folder.
2.
Select C4:C12.
3.
Select Home|Styles group|Conditional Formatting drop-down|Color Scales.
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4.

In the top row of the palette, click the second pattern from the left.

Color scales compare the relative magnitude of values in a cell range by applying
colors from a color set to your cells. The intensity of the cell's color reflects the
value's tendency toward the top or bottom of the values in the range.
5.
6.

Select F4:F12.
Select Home|Styles|Conditional Formatting drop-down|Data Bars.
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7.

Click the light blue data bar format.

Data bars summarize the relative magnitude of values in a cell range by extending
a band of color across the cell.
8.
9.

Select I4:I12 (eye).
Select Home|Styles group|Conditional Formatting drop-down|Icon Sets.
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10.

In the left hand column of the list of formats that display, click the three traffic
lights.

Icon sets are collections of three, four or five images that the system displays when
certain rules are met.
11.
12.

With I4:I12 still selected, select Home|Styles group|Conditional Formatting dropdown|Manage Rules.
Click the icon set rule and click Edit Rule.
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13.
14.
15.
16.
17.

Select the Reverse Icon Order check box to reconfigure the rules so the red light icon
is at the top and the green light icon is at the bottom.
In the Red light icon's row, click the Type field drop-down and click Percent.
In the red light icon's Value field, type 80.
In the yellow light icon's row, click the Type field drop-down and click Percent.
In the yellow light icon Value field, type 67.

18.

Click OK twice to clear the dialogs.

Excel formats the selected cell range. When you click a color scale or icon set in
the Conditional Formatting Rule Manager and then click the Edit Rule button, you
can control when Excel applies a color or icon to your data.
19.

Click C15.
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20.
21.
22.

Select Home|Styles group|Conditional Formatting drop-down|Highlight Cells
Rules|Less Than.
In the left field, type 96%.
Click the With drop-down and click Red text.

23.

Click OK.

The customer satisfaction does not meet the 96% criteria so C15 displays in red.
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24.
25.
26.

Save the current file as My Dashboard.
Close the current file.
Leave the application open for the next exercise.
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USING TEXT FUNCTIONS
INTRODUCTION
As discussed earlier in this session, a function is a procedure which returns a
value. In Excel, there are several categories of function which as text function.
Text functions can be used for various purposes, such as to combine the text in
two cells into one cell or to remove an extra space from a string.
USE TEXT FUNCTIONS
Excel provides several functions that you can use to manipulate or get information
about text data. For example, you can use the FIND function to locate a sequence
of characters or a string within text data, or you can use the CONCATENATE
function to combine two or more strings into one. The following table describes
these and other text functions.
Function/Syntax
CONCATENATE(Text1, Text2,
Text3….)
LEFT(Text,
NumberOfCharactersToExtract)
LOWER(Text)
MID(Text, StartPosition,
NumberOfCharactersToExtract)
PROPER(Text)

RIGHT(Text,
NumberOfCharactersToExtract)

Description
Combines all strings listed as
arguments into a single string
Extracts the specified number of
characters from the beginning of
the string
Converts all letters of the string to
lower case
Extracts the specified number of
characters from the specified
position in the string
Converts the first letter of all
words to upper case and all other
letters to lower case
Extracts the specified number of
characters from the end of the
string
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TRIM(Text)

UPPER(Text)

Removes extra spaces from the
string, leaving a single space
between words
Converts all letters of the string to
upper case

SCENARIO
Tour Text worksheet contains details about various products. The product code
comprises seven characters. The first two characters signify the product category
and the third and fourth characters signify the order year. The last three
characters indicate the serial number of the product within its category.
To use Text functions:
1.
Launch Microsoft Excel in your favorite manner.
2.
Open Functions2 from the student folder.
3.
Save the workbook as My Functions2.
4.
Observe the data in the worksheet.
5.
Select C6 to extract the product category from the product code.
6.
Type =LEFT(A6,2) and depress Enter.
A6 is the cell containing the source string. The 2 indicates that two characters
need to be extracted from the beginning of the source string. The function returns
the product category of PR.
7.
8.

Copy the formula in C6 to C7:C15.
Select D6.

You now want to extract the order year from the product code.
9.

Type =MID(A6,3,2) and depress Enter.

The function returns 99, the third and fourth characters in the string.
10.

Select D6.
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You want to edit the formula to display the order year in a four-digit format.
11.
12.
13.

Modify the formula to read =CONCATENATE(19,MID(A6,3,2))
Depress Enter to combine 19 with 99.
Select D6.

You will edit the formula to check if the third character of the product code is 0. If
true, the formula in D6 will concatenate 20 and the result of the MID function. If
false, it will concatenate 19 and the result of the MID function.
14.

Modify the formula to read
=IF(MID(A6,3,1)="0",CONCATENATE(20,MID(A6,3,2)),CONCATENATE(19,
MID(A6,3,2)))

The formula concatenates 19 and the result of the MID function because the third
character of the product code in A6 is not “0.” Beware-Keep trying as it really
does work!
15.
16.
17.
18.

Depress Enter and 1999 displays.
Copy the formula in D6 to D7:D15 to display the order year in a four-digit format
for all products.
Update the workbook.
Leave the workbook active for the next exercise.
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INFORMATION FUNCTIONS
INTRODUCTION
You can use information functions to obtain information about the work
environment or contents of a cell or range. For example, you can use the INFO
function to determine the type of operating system used and the ISBLANK
function to find out whether a cell is blank.
IS FUNCTION
Excel provides several IS functions that can check for a specific type of value in a
cell or range of cells. This function returns TRUE if the cell contains the correct
value, or else FALSE. You can use information functions in combination with the
IS functions to perform calculations. All IS functions have the following syntax:
=IS<<function>>(value)
The following table describes some IS functions:
Function
ISBLANK
ISERR
ISERROR
ISLOGICAL
ISNA
ISNONTEXT
ISNUMBER
ISREF
ISTEXT

Returns TRUE if….
The specified cell is empty
The specified cell contains any error value except
#N/A
The specified cell contains any error value
The specified cell contains a logical value
The specified cell contains the error value #N/A
The specified cell or range contains blank space or
a value that is not text
The value in the specified cell contains a number
The formula in the specified cell returns a cell
reference
The value in the specified cell is text
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SCENARIO
You want to calculate the annual regional sales for the products by referring to the
data in the Sales sheet. However, for the products for which data is missing in the
Sales sheet, you will display “Data is not available” in the IS sheet.
To use IS functions:
1.
Continuing from the previous exercise, activate the Sales sheet.
Observe the sales data is missing for some products.
2.
3.
4.

Activate the IS sheet.
Select C5.
Type =IF(ISBLANK(Sales!F5),”Data not available”,SUM(Sales!C5:F5))

The ISBLANK function checks whether cell F5 in the Sales sheet is blank. If true,
the formula returns “Data no available.” If false, the SUM function calculates the
total sales for the product. The value 82.333 displays because F5 in the Sales sheet
is not blank.
5.
6.
7.
8.

Copy the formula in C5 to C6:C34.
Remove any values from the blank lines.
Update the workbook.
Leave the workbook active for the next exercise.

THE CELL FUNCTION
You can use the CELL function to determine the contents, formatting, or location
of a cell. The syntax is as follows:
=CELL (InformationType,CellReference)
Here the first argument indicates the type of information you want. For example,
if you want to know the contents of cell H100 in the current worksheet, use the
function =CELL(“contents”,H100). The following table describes the various
information types you can specify:
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Type
address
col
color
contents
format
parentheses
prefix

protect
row
type
width
filename

Description
Returns the address of the selected cell
Returns the column number of the selected cell
Returns q if the cell is formatted to display negative
number in red, otherwise returns 0
Returns the contents of a cell
Returns a value corresponding to the formatting of the
selected cell
Returns 1 if the content is within parentheses, otherwise
returns 0
Returns a single quote mark if the text in the selected
cell is left aligned, a double quote if the text is right
aligned, a backslash for fill aligned text and empty text
(“”) for other contents
Returns 1 if the cell is locked, otherwise returns 0
Returns the row number of the selected cell
Returns “b” if the text in the selected cell is blank, “1”
for text, and “v” for types such as number and date
Returns the column width of the selected cell
Returns the location of the file containing the referenced
cell. If no cell reference is specified, the function returns
the location of the file containing the current cell

SCENARIO
The manager of Outlander Spices wants to replace the “Data not available” text
with the comment available in column G of the Sales sheet for the corresponding
product.
To use the CELL function:
1.
Continuing from the previous exercise, in C5, modify the formula to read
=IF(ISBLANK(Sales!F5),CELL(“contents”,Sales!G5),SUM(Sales!C5:F5))
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The ISBLANK function checks whether cell F5 in the Sales sheet is blank. If true,
the formula returns the contents of G5 in the Sales sheet. Otherwise, the SUM
function calculates the total sales for the product.
2.

Depress Enter.

The value 82.333 displays because F5 in the Sales worksheet is not blank.
3.

Copy the formula in C5 to C6: C34.

Observe C9. Move to G5 on the Sales sheet to see the text “Removed from
product line” was entered as a result of the Cell function.
4.
5.
6.

Remove any values from the blank lines.
Update the workbook.
Close the current workbook.
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USING NAMES
INTRODUCTION
A name is a meaningful description that you assign to a cell or range of cells.
After a name has been assigned, you can use it in formulas in place of cell
references, making your formulas easier to understand. For example, in the
formula =SUM(Qtr1), Qtr1 is the name assigned to the range of cells representing
Quarter 1 data. You can use the Create Names command and the Apply Names
command to assign names to cells.
DEFINING NAMES FOR CELLS OR RANGES
Names must begin with a letter or an underscore and cannot include spaces.
You can also define named that refer to the same cell or range of cells across
multiple worksheets. These names are called 3-D names.
SCENARIO
In this exercise you will define names to represent ranges in this workbook. You
will also use these names in formulas.
To define names:
1.
Launch Microsoft Excel in your favorite manner.
2.
Open Names from the student folder.
3.
Save the workbook as My Names.
4.
Confirm the North sheet is active.
5.
Select B5:B9.
6.
Edit the Name box to read N_qtr1
The N represents the North data.
7.
8.
9.
10.

Depress Enter.
Name C5:C9 as N_qtr2 and depress Enter.
Name D5:D9 as N_qtr3 and depress Enter.
Name E5:E9 as N_qtr4 and depress Enter.
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Oops, you find these are not the best possible names for your ranges so you
decide to change them.
11.
12.
13.
14.
15.
16.
17.
18.

Select the name to be modified. In this instance, select N_qtr1 in the name box.
Select Formulas tab|Defined Names group|Name Manager to open the Name
Manager dialog.
Click on the N_qtr1 entry.
Click the Edit button.
At the Edit Name dialog, modify the name to read QTR1_sales.
Edit the names of the additional ranges, as noted above.
Click to close the Name Manager dialog.
Update the workbook.

THE CREATE NAMES COMMAND
You can use the existing column and row labels as names for the cells they
represent.
To create names by using existing labels:
1.
Select the range or ranges you want to name, including the row or column labels.
In this instance we will use B4:B9.
The cells containing the row or column labels will not be included in the named
range. They are selected to provide the appropriate labels.
2.

Select Formulas tab|Defined Names group|Create from Selection to open the
Create Names dialog.
3.
Select the selected range. In this instance it will be Top row.
4.
Click OK.
5.
Repeat the above for each range.
6.
Next you will need to name the quarterly totals, using the Define Name method,
and naming them Qtr1_total, etc.
Now that you have your ranges all named, it is time to use these names in
formulas.
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7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.

Click in H10.
Depress the equal sign (=).
Select Formulas tab|Defined Names group|Use in Formula
Select Qtr1_total from the offered list.
Add a plus sign (+) to your formula.
Click on Use in Formula again.
Select Qtr2_total from the list.
The total for the first and second quarter will display in the selected cell.
Click on the Product Sales tab.
Click in H10.
Repeating the above, add the sales from the third and fourth quarters.

Note – It is using the data from the North tab, not the currently selected tab.
18.
19.

Close the current workbook without saving your changes.
Leave the application active for the next exercise.
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DECISION MAKING FUNCTIONS
INTRODUCTION
You can use functions such as IF and SUMIF to perform calculations based on
conditions. The IF function returns one of two values based on whether the
condition you provide is true or false. The SUMIF function calculates the sum of
only the values that meet a specified criterion within a range.
THE IF FUNCTION
The IF function evaluates a condition. If the condition is true, the function returns
a specific value. Otherwise, it returns another value. The syntax of the IF function
is:
IF(condition, value_if_true,value_if_false)
In this syntax, condition is the criterion you want the function to evaluate,
value_if_true is the value to be returned if the condition is true, and value_if_false
is the value to be returned if the condition is false.
SCENARIO
You will use the IF function to calculate the commission for each salesperson. If
the total sales value is greater than $10,000, the commission should be calculated
as 2% of the total sales. Otherwise, “Not applicable” should display in the cell.
To use the IF function:
1.
Launch Excel 2003 in your favorite manner.
2.
Open Advanced formulas from the student folder.
3.
Save the workbook as My Advanced Formulas.
4.
Confirm the IF worksheet is active.
5.
Select G7.
6.
Type =IF(F7>10000,F7*2%,”Not applicable”) and depress Enter.
The value $249 displays in G7.
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7.
8.
9.
10.

Copy the formula in G7 to G8:G21 to calculate the remaining commissions.
Observe the omission column.
Update the workbook.
Leave the workbook active for the next exercise.

THE SUMIF FUNCTION
You will use the SUMIF function when you want to add values within a range of
cells based on the evaluation of a criterion in another range.
The syntax of the SUMIF function is:
SUMIF(evaluation_range,evaluation_criteria,sum_range)
In this syntax, evaluation_range is the range in which the function will test the
criterion specified in evaluation_criteria. The argument sum_range specifies the
actual cells whose values are to be added.
SCENARIO
See if you can figure out what the scenario is for this exercise.
To use the SUMIF function:
1.
Continuing from the previous exercise, activate the SumIF worksheet.
2.
Explore for named ranges.
3.
Select B29.
4.
Type =SUMIF(Region,”East”,Sales_03)
5.
Depress Enter.
The value $43,685.00 displays.
6.

In B30, display the East region’s total sales for 2004 by using the name of the range
Region,Sales_04, in the SUMIF function.

The value $56,320.00 displays.
7.

In E29, display the North region’s total sales for 2003.
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The value $65,040.00 displays.
8.

In E30, Display the North region’s total sales for 2004.

The value $70,950.00 displays.
9.
10.

Update the workbook.
Close the current workbook.
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